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I. PURPOSE 

This document: 

• establishes basic style and format conventions for reviews and submission 
summaries associated with a Submission Tracking and Reporting System (STARS) 
submission,1 and 

• provides general information on the content of reviews and submission summaries. 

II. SCOPE 

ONADE personnel are responsible for preparing their reviews or stand-alone submission 
summaries using the office templates. When you prepare a review, stand-alone 
submission summary, or a memo to file (MTF), prepare an electronic document for the 
file. If the review document pertains to multiple submissions within a single administrative 
file (e.g., investigational new animal drug (INAD) file, new animal drug application 
(NADA)) or if the review document pertains to multiple administrative files, you may write 
a single review to cover all submissions. When closing the submissions out in Appian, 
upload an electronic file for each administrative file unless the submissions are linked in 
STARS (see P&P 1243.3030 for more information). See standard operating procedure 
1243.000.007 for information on grammar standards for final action packages that 
undergo a quality control review by the Quality Assurance Team. These documents 
should adhere to the following format and style conventions. 

A. Margins 

The document should have a 1-inch margin on all sides of the page. Tables may 
extend beyond these margins for readability. 

B. Fonts 

• To insert a symbol, select the Insert ribbon in Word and select Symbol dropdown. 
In our documentation, the standard format for the trademark (™), copyright (©), 
and registered trademark (®) symbols is superscript. When inserting the 

 
1  If the final action for a submission is File No Reply (FNR), do not prepare review documentation (review or stand-alone 

submission summary). If the final action is FNR w/memo, prepare appropriate review documentation. The ONADE review 
template may be used and/or modified as needed to accommodate memos to the file. 
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registered trademark or copyright symbol, it must be manually superscripted to 
have it in the correct format. Ensure the font is 11-point Arial font when you insert 
Greek letters and other characters and symbols. It is at the discretion of the 
reviewer to either use the appropriate trademark/copyright symbol, including the 
proper formatting of the symbol, throughout the internal review documentation 
being prepared or to use the appropriate trademark symbol the first time the 
proprietary name is used in the review and not repeat use of the symbol 
throughout the remainder of the document. 

• Statistical equations and similar situations should be added to documents as an 
image file with appropriate alternative text. 

• Do not embed fonts used in the document. See P&P 1243.3005 for instruction on 
how to ensure fonts are not embedded. 

C. 508 Compliance 

Review and Submission summary documents should be created in a manner that 
conforms to Section 508 of the Rehabilitation Act. 

D. “Clean” Electronic Files 

Critically examine the electronic file of the review document(s) to remove all traces of 
information that are not part of the body of the file (i.e., track changes). All electronic 
files should be “clean” (see P&P 1243.3005). 

E. Submission Descriptor Block 

1. The submission descriptor block on the first page is right justified. 

2. The principal submission identifier field is the first line in the submission descriptor 
block and is in bold type. Typically, this field identifies all principal submission(s) 
included in the review or submission summary. However, it is possible for a 
reviewer to have only an amendment assigned to them as a consult request in 
STARS, and not the parent submission. In those instances, it is appropriate to 
identify the document type and the identification of the amendment in the first line 
of the descriptor block. 

The principal submission identifier consists of the one uppercase letter 
designation of the document type, the 6-digit document number, the one 
uppercase letter designation of the submission or amendment type, the 4-digit 
submission number and the 2-letter subclass code (except for amendments), 
separated by dashes. Immediately following the subclass code, add the package 
ID in parentheses (e.g., N-012345-C-0123-CP (AA) for a primary review, N-
012345-C-0123-CP (A1) for a consulting review, or N-012345-T-0123 (A1) for a 
consulting review of an amendment only). 

If the review applies to a group of principal submissions, include identification of 
all principal submissions in this field. The display order of multiple principal 
submissions is determined by sequentially alphabetizing by document type, 
placing in numerical order by document number within document type, and, if 
necessary, placing in numerical order by submission number within a document. 
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• If the multiple submissions include linked submissions, then display the lead 
submission (that is identified by an L in STARS) first, regardless of document 
type, document number, or submission number followed by the linked 
submissions (identified with an asterisk in STARS) using the display order 
described above. See P&P 1243.3030 for a definition of linked submissions 
and the administrative process to be followed. 

• For a review that addresses two principal submissions, list the submissions on 
consecutive lines using the display order indicated above. 

• If the review addresses multiple principal submissions, you may find it helpful 
to display this information in a multi-row multi-column table. This table should 
contain columns of equal width spanning the text area (6.25”). You should fill 
the table cells using the display order in a “top to bottom” order within a 
column and “left to right” by columns. Set the format of the table borders to 
“None”.2 Right-justify the table cell contents. See Appendix 1 for examples. 

3. Include the target animal species and class description for the relevant project 
below the proprietary or established name.3 This is not required for manufacturing 
or toxicology reviews. If the species or class description is exceedingly long, 
abbreviate this information. Provide a complete description of the species and 
class in the review. For example, for a rodent study to support Human Food 
Safety for a lactating dairy cattle product, lactating dairy cattle would be the 
species and class description. 

4. Include sponsor’s complete name. This is the name of the sponsor, not a U.S. 
agent or company representative. If there is any doubt regarding the appropriate 
name, check the name associated with the application in STARS (in the Overview 
screen), or for submissions made via eSubmitter, use the “Establishment Name” 
from the “Firm Information” section of the submission. Do not include the 
sponsor’s address in the submission identifier information for a review or 
submission summary. 

5. The date in the descriptor information is the date the review was completed in final 
and is considered the official date of the review for reference purposes. This date 
may differ from the date found in the electronic signature page. 

F. Review Title 

The title of the review reflects the type of review. Format the title so that it is centered, 
bolded, and in all caps. Optionally, you may also include the submission’s STARS 
received date and a secondary title beneath the main title if it adds to the clarity or 
completeness of the administrative file. For example: 

  

 
2 To set the table borders to “None” in Word, select the table (by dragging to highlight the table, clicking in the table and then on the 

“table square” near the top left of the table, or clicking in the table and then clicking (in succession) “Table” on the “Tools” menu, 
“Select” from the drop-down menu, and then “Table” in the secondary menu). Once the table is selected, click “Format” on the 
“Tools” menu, click “Borders and shading” from the drop-down menu, click the “Borders” tab, click the “None” setting, and accept 
the command by clicking the “OK” button or pressing the “Return” key. 

3 Relevant project applies to all file types (i.e., NADA, INAD, JINAD, ANADA, GC, VMF). 
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RESIDUE CHEMISTRY REVIEW 
(Submission received date e.g., June 1, 2003) 

Assessment of the drug formulation components 

If you are writing a stand-alone submission summary for the principal submission, title 
it “SUBMISSION SUMMARY.” 

G. Document Header Information 

Reviews or stand-alone submission summaries exceeding one page in length have a 
right-justified two-line header beginning 0.5 inches from the top paper edge.4 The 
header consists of the principal submission identifier (e.g., I-012345-P-0123-MC (AA)) 
on the first line and the review title or submission summary and a “Page x” entry on 
the second line (e.g., Residue Chemistry Review, Page x). The header should be 
visible on the second and subsequent pages. Add your package ID in parentheses 
immediately following the principal submission identifier (see Section C.2 above). The 
document header does not include information for amendments. 

If the review addresses two principal submissions from one administrative file or one 
submission from each of two administrative files, use two lines to identify the principal 
submissions. Example (Principal Submission Review): 

I-012345-P-0100-NV (AA) 
I-013001-P-0004-NV (AA) 

Environmental Review, Page 2 

If the review addresses three or more principal submissions, identify only the first 
submission listed in the principal submission identifier field followed by the phrase “et 
al.” to indicate the additional submissions. Example: 

N-012345-C-0100-CP (B1), et al. 
Residue Chemistry Review, Page 2 

H. Signature Block 

The signature block contains the author’s name and degrees held, title, review team 
or division if not affiliated with a team, mail code, and office. Indent the signature 
block 3 inches from the left margin. Your electronic signature represents an 
acknowledgement that you assume responsibility as the author of the document and 
that the document is complete and accurate to the best of your knowledge and ability. 
Example: 

{see appended electronic signature page} 
Joan Smith, M.S. 
Biologist 
Chemotherapeutics Team, HFV-143 
Office of New Animal Drug Evaluation 

 
4 Format the header by clicking on “Page Setup” from the “File” menu of Microsoft Word, selecting the “Layout” tab, checking the 

“Different first page” box, and setting the “Header” to 0.5 inches from the edge. 
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I. Appendices 

Occasionally, additional information such as emails or journal articles may need to be 
included in a review document. Place this information at the end of the review 
document after the signature block in the template. If there is more than one item, 
include each document as a separate, numbered appendix. 

III. PREPARING THE REVIEW DOCUMENT 

In your review, include a summary of the submission content, your evaluation of the 
information, and your conclusions. Clearly document what letter or correspondence is 
sent to the sponsor and identify all enclosures. To provide consistency between review 
divisions, use the Word template when writing your review. A general description of each 
section is presented below. 

A. Submission Summary (Section I of the Template) 

The submission summary is an “executive summary” of the entire submission. Briefly 
summarize the sponsor’s requests and the administrative history of the submission(s), 
including any amendments received. Note whether you requested consulting reviews 
and describe the relevant conclusions of all reviews performed, and the final 
decision(s) to communicate to the sponsor in the letter. If you do not use a consulting 
reviewer’s (CR) ‘Transmit to Sponsor’ section as written, provide a brief explanation in 
the submission summary (see P&P 1240.2110 for details on dispute resolution). Do 
not include a chronology or description of all previous submissions to the file or 
application in the submission summary. 

The submission summary is part of the AA review document. In certain situations, a 
stand-alone submission summary is prepared instead of an AA review or in addition 
to the summary in the AA review. See Section IV for details. 

In each consulting review, the title of this first section of the review is “Review 
Summary” (see template). In that section, summarize only that portion of the 
submission you (the CR) are reviewing and put it in context as it relates to the entire 
submission. It is important to identify all files or submissions used to formulate the 
scientific and or regulatory decision. At a minimum, this section identifies the parent 
submission regardless of whether the parent submission was assigned to the 
consulting reviewer or not. In situations where the CR is only assigned an amendment 
and not the parent submission, it is critical to ensure the completeness of the 
administrative record by identifying the parent submission in the Review Summary 
and clearly describing what request was received by the CR. 

B. Review (Section II of the Template) 

Document the submission review. Each division has flexibility to determine the 
specific format for this section. 

C. Conclusions (Section III of the Template) 

Document your conclusions with respect to the submission. Your conclusions form 
the basis for your recommendations described in section IV of the template. 
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D. Recommendations (Section IV of the Template) 

Document your recommendation(s) for the STARS final action or non-final action with 
respect to the submission. If appropriate, indicate the type of letter to be sent and list 
any enclosures that will be included with the letter that will be sent to the sponsor. 

E. Transmit to Sponsor (Section V of the Template) 

Provide, verbatim, the reviewer comments that are to be included in the letter to the 
sponsor. Include only your comments in the Transmit to Sponsor section and not 
those of other reviewers. Also, do not include standardized language for the issuing 
letter in the Transmit to Sponsor section. 

The letter to the sponsor will consolidate comments from all reviews and incorporate 
any standardized language. 

IV. PREPARING A STAND-ALONE SUBMISSION SUMMARY 

A reviewer will prepare a stand-alone submission summary when: 

• no review is written; or 

• there are complicated policy issues that occur after the review is completed but before 
the submission is closed out in STARS that impact the transmit to sponsor/outcome. 

A supervisor prepares a stand-alone submission summary when they override a 
reviewer’s recommendation and significantly alter the transmit to sponsor section. 

Include in the stand-alone submission summary: 1) items described in Section III. A. (as 
appropriate); and 2) a description of circumstances surrounding the preparation of the 
stand-alone submission summary, such as background information, meetings and their 
outcomes, and agreements. If the AA review has been completed, you could potentially 
have a stand-alone submission summary document in addition to the submission 
summary in the completed AA review. 

V. REFERENCES 

CVM Policies and Procedures Manual 

1240.2110 – Procedures for Resolving Scientific Data Disagreements within CVM 

CVM Program and Procedures Manual – ONADE Reviewer’s Chapter 

1243.2010 – Responsibilities for Keeping and Maintaining Records 

1243.3005 – Creating Clean Electronic Files 

1243.3030 – Completing Final Action Packages for Submission Tracking and 
Reporting System (STARS) Submissions 

ONADE Standard Operating Procedures 

1243.000.007 – Grammar Standards for Final Action Packages that Undergo a 
Quality Control Review by the Quality Assurance Team 
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VI. VERSION HISTORY 

September 4, 2007 – The information in this document was originally contained in 
ONADE P&P 1243.3030 (November 19, 2003 version). This P&P updates the process of 
preparing a review and submission summary and identifies when a stand-alone 
submission summary should be prepared. 

March 6, 2008 – Revised to include information on how to create and name amended 
review documentation. 

December 4, 2008 – Section II revised to identify on what color paper reviews and 
submission summaries are printed. Section III now includes instruction to identify in any 
review if a letter and any attachments are being sent to the outside party, state that the 
AA review prepares the submission summary, and all consulting reviews have a review 
summary. 

April 3, 2009 – Revised to include information specific to ERA processes. 

October 14, 2011 – Revised to describe processes changed by implementation of Appian 
and electronic close out of review documentation. 

October 7, 2015 – Revised to change all margins to 1.0” and remove Appendix 2 
additional instructions for submissions received prior to March 14, 2011.  

November 6, 2015 – Revised to remove all references to the ERA process and to clarify 
the method for added equations to documents. 

June 21, 2016 – Revised to current format, removed instruction to embed fonts within 
documents, and added information relevant to receiving a consulting review for an 
amendment only. 

August 13, 2018 – Revised to include information how to reference linked submissions in 
the submission descriptor block of the review in section II. E. 2. 

November 14, 2018 – Revised to include more details about the target animal species 
and class in the descriptor block and to clarify it is not the species or class of animal on 
which a study is conducted per se. It is to be the target animal and class for the relevant 
project for the new animal drug product. In section II. Format and Style Conventions, the 
section on Other Administrative Information was removed. We no longer include such 
information at the end of the review or submission summary. 

December 27, 2019 – Revised to remove the reference to the “Other Administrative 
Information Box” in the template in section I. Appendices. We no longer have the 
administrative information box in the template. 

January 26, 2021 – Updated section II. B. to clarify information about inserting and 
formatting symbols within our documents. It specifically states that the reviewer may 
decide whether to repeat the trademark symbol throughout their internal review 
documentation or to use the trademark symbol the first time the proprietary name is used 
and not repeat it throughout the remainder of the document. 

July 21, 2022 – Quality systems review for minor formatting updates. 
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March 29, 2023 – Updated the information on standards to reflect the office switch to 
Arial 11-point font as our standard font. To bring all office quality system documentation 
into compliance with the FDA Visual Identity Program approved fonts, ONADE has 
adopted Arial 11-point font. The font of this document was changed from Verdana 10-
point font to Arial 11-point font. 

April 5, 2024 - Edited section III. to include reference to the SOP on grammar standards 
for final action packages that undergo a quality control review by the QA Team. 
Reviewers may choose to apply those standards to other reviews and review 
documentation they prepare. The document was also put into the current office format 
and template. 
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APPENDIX 1. FORMAT FOR MULTIPLE SUBMISSION IDENTIFIERS 

List the submission identification information in a logical way that makes it easy for the reader to 
understand to which submissions the identification information pertains. For example, if the 
same information (e.g., proprietary and drug product established name, outside party 
information) pertains to multiple submissions being addressed in the same review or stand-
alone submission summary, list all the principal submissions in numerical order followed by the 
remaining information, as shown here. 

I-012345-P-0161-EF (AA) 
I-012346-P-0162-EF (AA) 
I-012347-P-0159-EF (AA) 
I-012348-P-0054-EF (AA) 

Proprietary name 
(drug product established name) 

Species and animal class 
Sponsor's name 
January 1, 2007 

If the information is not the same for all the principal submissions being addressed in the review 
or stand-alone submission summary (e.g., if different products are involved), list the “different” 
information with each principal submission, followed by the information that is common to all the 
submissions. The example below shows how to present the information for applications with 
different proprietary names; they may or may not have the same established name. If there are 
more than three submissions, use a table, as shown here. 

N-012345-C-0119-CI (AA) 
Proprietary name 

(drug product established 
name) 

 

N-012347-C-0109-CI (AA) 
Proprietary name 

(drug product established 
name) 

 

N-012349-C-0115-CI (AA) 
Proprietary name 

(drug product established 
name) 

N-012346-C-0109-CI (AA) 
Proprietary name 

(drug product established 
name) 

 

N-012348-C-0115-CI (AA) 
Proprietary name 

(drug product established 
name) 

N-012350-C-0110-CI (AA) 
Proprietary name 

(drug product established 
name) 

  N-012351-C-0033-CI (AA) 
Proprietary name 

(drug product established 
name) 

 
If multiple species and/or classes are involved, it is acceptable to truncate the information (e.g., 
write “Cattle” instead of “Cattle: Beef, Non-lactating Dairy, and Lactating Dairy”, or write 
“Multiple Species and Classes” instead of listing each individual species and class). Include the 
detailed species information in your submission summary or review summary. Species and 
class information is not required on reviews or stand-alone submission summaries for 
Chemistry, Manufacturing, and Controls submissions. 
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